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Programming in Vista:fit software  
 

This guide will lead you through the steps of fitting hearing instruments using Vista:fit 

fitting software. Some screens or features described in this software instruction guide 

may not be available with all products. Prior to detecting the hearing instrument(s), 

choose your desired programming interface: 

• If using iCube, insert batteries into the hearing instruments and close the 

batterydoor. Place hearing instruments on your client’s ears and place the iCube 

around your client’s neck or place the hearing instruments inside the iCube neck 

loop. 

• If using NOAHlink or HI-PRO with BTE or RIC hearing instruments, open thebattery 

door and insert the programming cable into the programming port. 

Connect the other end of the cable to the NOAHlink or HI-PRO. 

• If using NOAHlink or HI-PRO with ITE hearing instruments, remove the batterydoor 

and insert the programming cable. Connect the other end of the cable to the 

NOAHlink or HI-PRO. 

Note: Hearing instrument controls, accessories, Auto Phone, Auto DAI, audio streaming, 

and automatic microphone options are deactivated during programming. 

Note: BTE and RIC hearing instruments are initially quick fit to a 40 dB HL flat hearing 

loss configured for the left ear upon shipping. ITE hearing instruments are quick fit to 

the client’s audiogram if supplied; otherwise, the devices are quick fit to a 40 dB HL flat 

hearing loss.  

Note: For IIC products or 10A custom products, ensure you are using the white 

programming cable to avoid damaging the hearing instrument. 

When you are ready to program your hearing instruments in Vista:fit, certain sections 

of the screen (Main Menu, Tool Bar, Quick View Pane) will remain constant during the 

fitting process. Brief descriptions of these sections are found below. 

 

 
 

Main section  
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Main menu 
 

The main menu is available at the top of each screen and consists of these options: 

File 

• Import client: imports previously exported Vista:fit client data. After selecting 

this option, the fitter must select the source file location from the provided 

window.  

• Export client: exports Vista:fit client data from the software. After selecting this 

option, the fitter must choose the destination and name of the exported file. 

Export options include: 

• Export all clients: exports all client files from the Vista:fit database 

• Export anonymously: removes client name from the exported file and assigns 

an 'anonymous' file name identifier. 

• Export to NOAH: exports client file in a format that can be imported into 

NOAH. 

• Print: opens a window that shows the documents available such as the Fitting 

Reports and the Getting Started Guides (hearing instruments and accessories, if 

applicable). The client's language for the Getting Started Guides can be selected. 

The selected documents can be previewed, printed or saved from this window. 

• Save: saves the current fitting information. Choose from Save to hearing 

instrument, Save to database, or Save to accessories (if accessory added to 

fitting). 

• Close Vista:fit: exits the software application. You will be prompted to save your 

fitting information if you have not done so before closing Vista:fit. 

Hearing Instrument 

• Save: saves the current fitting information. Choose from Save to hearing 

instrument, Save to database, or Save to accessories (if accessory added to 

fitting).  

• Test Mode: sets the hearing instrument into a test mode so you can compare the 

electroacoustic performance of the device to the published ANSI / IEC specification 

data sheets.  

• Verification Mode: sets the hearing instrument into a verification mode to allow 

testing without the interference of adaptive features. There are 3 options:  

• Adaptive features active: default state. 

• Real Ear Verification: all adaptive features are disabled except for Natural Sound 

and input selection. 

• 2cc Coupler Verification: all adaptive features and input selection are disabled. 

• HI Update: checks if newer functionality is available for the connected hearing 

instrument. If an update is available, the instrument maintains its fine tuning and 

new features become enabled. 

Note: It is recommended to use NOAHlink or HI-PRO when running HI Update.  

• HI Repair / Reset: opens a wizard to reset the firmware of a hearing instrument. 

Only use this when directed by an error message. If this was not successful, please 

try again before sending the hearing instrument back to your distributor. The client 

record stored in the database will not be affected. 
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Note: It is recommended to use NOAHlink or HI-PRO when running HI Repair / 

Reset.   

• Transfer Fitting: provides instructions on how to transfer a fitting to or from 

another hearing instrument. 

Options 

• Preferences: generates the user preferences dialog box with the following 

options: 

General: 

• Language: select the preferred language for text and sound files. 

• Presentation: select your preferred level of animations. 

• Support: generate Vista:fit logging information for support. 

• Activate Select: enter code here to enable Activate Select functionality. Choose 

the appropriate trial period defaults. 

Fitting Session: 

• Diagnostics: choose the preferred bone conduction symbol and view/adjust the 

DSL v5 ABR nHL to eHL correction values. 

• Fitting: indicate if the speech verification graph option will be available from the 

curve display options on the Pre Fitting screen. Choose whether to enable 

password protection to keep fitting information confidential. Following 

activation of this option, the fitter can insert their desired password into the 

software. If the Vista:fit software version being used by the fitter does not have 

the same password as the one saved to the hearing instrument, the fitter will be 

required to enter the correct code to proceed with the fitting.  

Note: Password protection prevents reading of information from a hearing instrument 

but does not prevent a fitter from creating a new fitting on that same device.  

• Presentation: select the preferred tuning values display (absolute or relative); 

select visibility options for CR values; hide or show preparation instructions for 

the feedback wizard and the in situ test wizard; select whether or not the 

pediatric fitting mode recommendation pop-up box is displayed; and choose 

whether or not to maintain the aspect ratio of graphs. 

• Pediatric Modes: View and / or edit the fitting mode defaults for various 

pediatric age ranges using the provided tables. Modify aspects related to fitting 

formula, global parameters, hearing instrument options, program settings, and 

program options.  

• Standard Mode: View and / or edit the fitting mode defaults for standard mode 

(adults) using the provided tables. Modify aspects related to fitting formula, 

global parameters, hearing instrument options, program settings, and program 

options.  

Reports: 

• Graphs: select the preferred graph type: Output or Gain. For the Output graph 

type, choose from: HL, SPL Real Ear, SPL 2cc, SPL Ear Simulator. For the Gain 

graph type, choose from: 2cc, Ear Simulator, Real Ear, Insertion Gain. 

Fitting Device: 

• Communication: fitting device management selects whether the fitting device is 

accessible by other programs while using Vista:fit. 

• NOAHlink: enable/disable the NOAHlink, perform a system check, configure 

properties, or start the pairing wizard. 
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• HI-PRO: enable/disable the HI-PRO, perform a system check or configure. 

• iCube: enable/disable the iCube, perform a system check via USB or wireless 

connection, upgrade iCube firmware, or start the iCube pairing wizard. 

Sound System: 

• Sound Output: select either stereo speaker or Aurical. 

• Calibration: calibrate to ensure media player sound files are presented at the 

correct level. Manual calibration uses a sound level meter. Play the calibration 

noise and adjust the Vista:fit volume slider and/or Windows volume slider until 

you measure 80 dB (A) at the listening position (where the client will sit). For 

Automatic calibration start the calibration wizard. This process uses the hearing 

instrument to measure and adjust the sound level. 

• iCube Configuration: opens the iCube configuration section in Preferences. The 

screen provides ability to enable/disable the iCube, perform a system check via 

USB or wireless connection, upgrade iCube firmware or start the iCube pairing 

wizard (i.e., add an iCube). 

• Accessory Firmware Update: opens a dialog box used to update uDirect™ 

devices and remote controls. The accessory must be connected to the computer 

using an USB cable. After detecting the device, Vista:fit will offer available 

firmware updates. 

Help 

• Support:  

• Generate Support Package: produces a .zip file with relevant support 

information that can be sent to customer support, for troubleshooting purposes. 

• Homologation Settings: sets the hearing instrument into a test mode used for 

certification of product parameters. 

• Export Client for Support: exports client data from the software for 

support/troubleshooting purposes. 

• Register with NOAH: registers Vista:fit with NOAH if it did not automatically 

get registered.  

• Unregister from NOAH: unregisters Vista:fit from NOAH.  

• About DSL v5: generates a dialog box displaying notices related to the DSL v5 

formula. 

• About Vista:fit: generates a dialog box displaying the software version and 

copyright notices.  
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Tool bar icons 
 

There are tool bar icons available at the top of each screen.  

The tool bar icons beside the Main Menu are: 

 Print icon: opens a window that shows the documents available such as the 

Fitting Reports and the Getting Started Guides (hearing instruments and 

accessories, if applicable). The client's language for the Getting Started Guides 

can be selected. The selected documents can be previewed, printed or saved 

from this window. 

Save icon: saves the current fitting information. Choose from Save to hearing 

instrument, Save to database, Save to accessories (if accessory added to fitting). 

Undo: undoes an action that was made in the fitting software. Undo is 

available within some tasks but the list of items to be undone will not carry over across 

Redo: redoes an action that was just undone. 

The tool bar icons above the Quick View Pane are: 

Quick Fit: quick fits the hearing instrument parameters based on the option 

selected in the Recalculate menu. The Recalculate menu is accessed with the 

drop-down arrow beside the Quick Fit icon. It provides the following options for 

the right, left or both hearing instruments: 

• Use Audiological and Acoustic Data: adjusts the hearing instrument response 

to account for change made on the Audiogram, RECD, REUG, Selection or 

Acoustics screens 

• Reset frequency response 

• Reset adaptive features 

• Reset tinnitus masker fine tuning  

Note: Only available if the product has the tinnitus masker feature. 

• Discard current fitting and start over: resets hearing instrument(s) to default 

settings 

Note: Quick Fit icon will highlight when a quick fit is recommended during the 

fitting. 

 

Mute / unmute icons: indicates the current state of the hearing instrument(s): 

muted or unmuted. Mute / unmute can be selected individually for each device 

or binaurally by clicking the centre of the button. The centre of the button also 

lists the currently active environment for the hearing instrument(s).  

 

Fitting Mode icons: Fitting mode is designed to efficiently provide 

ageappropriate hearing aid settings based on the unique fitting needs of 

children versus adults. When client information is entered and the age is 18 

years or less, Vista:fit will automatically prompt the fitter to select the 

appropriate fitting mode option via a pop-up window. The recommended fitting 

mode will be the one that corresponds to the client’s age. Age ranges are: 

• 0 to 4 years 

• 5 to 8 years 

• 9 to 18 years 
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• Standard fitting mode (default for 18+ years) 

The current fitting mode is indicated on the button above the Quick View Pane at 

the top right hand side of the screen at all times. The fitting mode can be changed 

by clicking on the button and selecting the desired setting from the drop-down 

box (In the main menu, see Options > Preferences > Fitting Session > Pediatric 

Modes table to view and / or edit fitting mode defaults.) 

Quick View Pane 
 

The Quick View Pane is a multi-tab panel in the upper right of the Vista:fit screen that 

provides useful information on the current status of the hearing instrument fitting. Each 

tab can be expanded by clicking on the plus sign to view additional details relating to 

that section.  

The various tabs serve different purposes: 

Client tab  

Provides the client’s name, number, last audiogram date, hearing instrument type and 

accessories. Clicking on the plus sign also provides access to more information on the 

hearing instruments, date of birth, and an area for note entry.  

Connection tab  

Lists current hearing instrument(s) along with the current connection status for each 

ear. An X icon next to the associated side (R or L) indicates the device is not 

connected, while a checkmark indicates the device is connected. If the connection is 

lost at any point, click the Detect bar on the Connection tab to reconnect. Click the 

plus sign to expand the Connection tab where you can see more options such as:  

• Selecting the desired programming interface (NOAHlink, iCube or HI-PRO) 

• Viewing the serial numbers 

• Quick access to print Getting Started Guides 

• Status of the Automatic Adaptation Manager including progress since the last 

fitting session, with a link to jump to the Adaptation Manager task 

• Summary of data logging from the hearing instrument, with a link to jump to the 

Data Logging screen 

• A link to jump to the Soft / Mod / Loud Controls 

The Connection tab will automatically open after detecting hearing aids for a follow-up 

fitting. If you would prefer not to have the Connection tab open automatically, you can 

uncheck this option at the bottom of the expanded Connection tab. 

Note: HI-PRO refers to the original HI-PRO, USB HI-PRO and HI-PRO 2. The HI-PRO that 

is actually used is configured using the HI-PRO configuration tool.  

Alerts tab  

Provides fitting help and alert messages during the fitting. A yellow-highlighted alerts 

tab appears momentarily to inform you of items that could impact your fitting should 

a fitter action result in the need to modify the hearing instrument (e.g., quick fit) or 

affect another software screen (e.g., program removal changes program toggle on 

remote control). Clicking the plus sign provides a list of all help and alert messages 

that have occurred during the current fitting. The alert messages are tally removed 
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after being addressed during the fitting, after closing a session or via the remove icon 

on the alert tab. 

Fitting menu overview 
 

Contains the main categories of a fitting: Client, Instruments, Fitting and End Fitting. 

The main section icons beside the fitting menu will change based on which fitting 

menu category is selected. For example, under Client, the main section icons are: 

Information, Experience Level, Audiogram, RECD, REUG. Details of each of these 

different sections are included in this software instruction guide.   
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Task navigation 
 

Once you have opened a task (e.g., Phase Canceller, Pulse Protector) by clicking the icon, 

you can move to your next task by either clicking the x icon on the header of that box, or 

by clicking directly on a different task. On some screen resolutions, you may need to use 

the navigation arrows along the bottom of the screen to scroll along and view the various 

task items that are available.  

 

Curve display options 

On any screen displaying a graph, you can change the items shown by clicking the curve 

display icon above the upper right graph. Adjustments made here are applied to both the 

left and right graphs.  

Depending on the section of the software, the fitter will have the option of choosing: 

• Gain: insertion gain, real-ear, 2cc or ear simulator. Also, option of showing 

feedback threshold obtained during the feedback test. 

• Output: HL real-ear, SPL real-ear, SPL 2cc or SPL ear simulator. Also, option of 

showing HTL (hearing threshold) and UCL (uncomfortable loudness) data. 

• Input / Output: SPL real ear, SPL 2cc or SPL ear simulator, each available at .5, 

1, 2, 4, 6, 8 kHz 

• Audiogram: displays current audiogram used in software 

• Show target: displays the target curve for the current view 

• Show calculated response: displays the original quick fitted hearing instrument 

response for the current view 

• Verification graph: (available in Pre-Fitting screen only if selected under 

Options > Preferences > Fitting Session > Fitting) displays hearing instrument 

response and target curves based on speech inputs at 50 / 65 / 80 dB SPL. 

Fitter has option of showing curves in gain (insertion gain; 2cc coupler) or 

output (SPL real-ear)  

Note: When the mouse cursor is positioned over items on the graph, a legend appears 

providing further details related to that item. 
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Client menu 

 

3. Click Save. A Client Summary table at the bottom of the screen will be 

populated with the client information and the client will be visible in the 

Clients and Sessions table.  

4. Click on the Blank Session  icon or button to start a 

new session for the client. 

To edit client information in the future, click on the Edit Client  button in 

the summary area, or click on the edit icon in the Clients and Sessions table.  

To find client information in the database: 

1. Type the client name and/or session information into the search field.  

2. Click the Search  icon. A list of client records matching the search 

criteria is displayed in the table. The list may be sorted by clicking the 

column headings. 

To create a fresh session for the client containing no previous audiometric 

or fitting information, click on the Blank Session  icon.  

In the Clients and Sessions table:  

• Double clicking on a client will open the last session for that client or if 

the client does not have any sessions it will open a blank session.  

• You can delete a specific client by clicking on the client and then clicking 

the Delete Client icon.  

• For each client you can view all of their session information by clicking on 

the chevrons  to the left of the client number.  

• You can open a specific session by clicking on that session and then 

clicking the Open Sessionbutton or icon.  

• You can delete a specific session by clicking on the session and then 

clicking the Delete Sessionicon.  

 

 

screen is primarily for reference. 

When running the Vista:fit standalone version, the Client 
 Information screen is the interface with the client 
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• You can create a blank session for a client by clicking on the client 

information and then clicking Blank Session 

Experience Level 

Select the client’s experience level with hearing 

instruments. Choose from: 

i. First Time ii. Short Term / Part Time iii. 

Long Term 

Note: The selected experience level with hearing 

instruments will impact the Quick Fit for the 

Automatic Adaptation Manager. 

Note: Be sure to Quick Fit after changing the 

Experience Level. 

Audiogram 

When running Vista:fit under NOAH, the 

audiogram screen is primarily for reference. The 

transducer used for audiometry and the tinnitus match 

sections are used as described below. To enter or change 

all other audiometric information, use the NOAH 

audiogram module. 

When running the Vista:fit standalone version, 

the audiogram screen provides the ability to 

enter the client’s audiometric test results.  

Select the transducer used for audiometry from 

the dropdown menu. Choose from: 

Headphones, Insert earphones, Custom 

earpiece (earmold); Loudspeaker 

(0, 45, or 90 degrees azimuth); ABR insert 

earphones (eHL or nHL); ABR custom earmold 

(eHL or nHL). 

Note: ABR eHL and ABR nHL data is only used 

with the DSL v5 fitting formula.  

To complete the audiogram, enter the data for the appropriate ear by clicking on the 

graph. Right clicking the graph provides the option to: Set point, Remove point, Remove 

all points or Copy (all curves) or Copy selected curve to the other ear. In addition, right 

clicking provides the option of specifying the measurement type for each data point; 

choose from: Unmasked, No response, Unmeasurable, Masked, Masked and no response 

or Masked and unmeasurable.  

To enter air conduction data, click on the AC button. 

To enter bone conduction data, click on the BC button. 

To enter uncomfortable loudness level data, click on the UCL button. 

Note: NAL-NL1 and NAL-NL2 do not use UCL data for target generation.  

To copy the entered curve from one ear to the next, click on the arrow icons above the 

graph for the respective ear.  

 To delete all of the curves on the audiogram, click on the Remove (Delete)  icon. 

Click on Use Audiogram to use the Audiogram for fitting formula targets. 

Click on Use In Situ to use the measured In Situ data for fitting formula targets.  
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Note: In cases where an In Situ measurement was previously conducted, you will see this 

information faded in the background behind the standard audiogram data when Use 

Audiogram is selected. 

If desired, speech sounds and common sound icons can be displayed on the 

audiogram for counseling purposes by selecting the check box for the desired 

information.  

Measured Tinnitus Match information can be entered at the bottom of the 

Audiogram screen.  

To enter tinnitus pitch match frequency, type in the value directly or choose a 

desired frequency via the dropdown box.  

Note: The entered frequency must be between 125 Hz and 16000 Hz. 

To enter the corresponding tinnitus loudness level (in dB Sensation Level i.e., 

number of dB above threshold at the pitch match frequency), type in the 

value directly or choose a desired dB SL value via the dropdown box. Note: 

The entered level must be between 0 and 20 dB SL. 

Note: Tinnitus match information is only used in the pre-calculation of the 

tinnitus masker noise. 

RECD 

This screen provides the option to enter real-earto-

coupler difference (RECD) values. If RECD values have not 

been measured, age-appropriate average values generated by 

the selected fitting formula will be used for the quick fit 

calculation. 

To complete the RECD screen, enter the data for the 

appropriate ear by clicking on the graph. Right 

clicking on the graph also provides the option to: Set 

Point, Remove Point, Remove all points or Copy 

to the other ear.  

To copy the entered curve from one ear to the other, 

click on the arrow icons above the graph for the 

respective ear. To remove the curve, click on the 

Remove (Delete)  icon. 

Select the earpiece used during the measurement 

from the drop-down menu; choose from: Custom earmold vented, Custom 

earmold occluded or Foam eartip. Vista:fit will default to the appropriate 

2cc coupler reference. 

Click on Use Entered to use the RECD data entered into the graph as the basis 

of fitting formula targets. 

Click on Use Average to use age appropriate average RECD values as the basis 

of fitting formula targets. 

Note: If a hearing instrument is already selected a grey curve will appear on 

the RECD graph. This grey curve represents the average data for the client’s 

age and earpiece condition.  
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REUG  

This screen provides the option to enter real-ear 

unaided gain (REUG) values. If REUG values have not been 

measured, age-appropriate average values generated by the 

selected fitting formula will be used for the quick fit 

calculation.  

To complete the REUG screen, enter the data for the 

appropriate ear by clicking on the graph. Right 

clicking on the graph also provides the option to: 

Set Point, Remove Point, Remove all points or 

Copy to the other ear.  

To copy the entered curve from one ear to the other, 

click on the arrow icons above the graph for the 

respective ear. To remove the current curve, click on 

the Remove (Delete)  icon. 

Select the sound field speaker location used during the measurement 

from the drop-down menu, choose from: 0 degrees, 45 degrees or 90 

degrees azimuth. 

Click on Use Entered to use the REUG data entered into the graph as the 

basis of fitting formula targets. Click on Use Average to use age appropriate 

average REUG values as the basis of fitting formula targets. 

Note: If a hearing instrument is already selected a grey curve will appear on 

the REUG graph. This grey curve represents the average data for the client’s 

age and speaker location.  

Instruments menu 

 

assigned to a side (right or left). Select the Play beep button in the Detection 

dialog window to confirm the side assigned to each instrument.  

 

 

detect or simulate a hearing instrument fitting.  

 

 Choose the desired programming interface from the 

       

Note: If using iCube for the first time, you will need to 

   

  

 

 

 

   button to perform a binaural 
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3. In cases where the data in the hearing instrument differs from that stored in the 

software: 

• Click Use fitting from hearing instrument to use data stored in the 

hearing instrument (including any data logging / learning information). 

• Click Use fitting from this session to use data stored in the software. 

• Click Create new fitting to setup the hearing instrument using software 

defaults. 

The hearing instrument model, style, matrix and serial 

number are displayed after detection along with the 

audiogram and fitting range for each side. In addition, 

the communication status is updated on the Connection 

tab of the Quick View Pane (upper right corner of 

screen). For most product styles, you will also have a 

couple of acoustic options that you can select here or 

you can go to the full list under Instruments > Acoustics. 

Any changes made here will also be updated on the 

Instruments > Acoustics screen.  

Simulate hearing instrument(s): 

1. Click the button for your desired product line in the 

hearing instrument simulation section on the left 

hand side of the screen. If you know what technology 

level you want, you can also click directly on the technology level button 

within the product line button to skip step 2. 

2. Click on the desired technology level. To see more information about the 

different technology levels, click on the + sign beside the Technology Level 

title to view a feature comparison.  

3. Select the desired style for that product line and technology level. To see 

more information about each style, click on the + sign beside the Styles title.  

Note: When selecting a product style for simulation, clicking the centre of the 

button performs a binaural selection, while clicking the R or L buttons 

performs a monaural selection. 

At the top of the screen, under Current Product in this Session, you can see a 

summary of the products you have selected. For most product styles, you 

will also have a couple of acoustic options that you can select here or you 

can go to the full list under Instruments > Acoustics. Any changes made here 

will also be updated on the Instruments > Acoustics screen. Furthermore, if 

you wish to detect a product while on the simulation screen, select the 

desired programming interface from the drop-down menu in the upper left 

column of the screen, and then click Detect. The process will follow the steps 

outlined above in the Detect hearing instruments section of this guide. 
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Technology Change 

Select the Technology Change screen to access 

the buttons used to change the technology level of 

a hearing instrument. With trial devices, the fitter 

can select from one of the displayed technology 

levels. Clicking on one of the technology level 

buttons will launch the Change Technology Level 

wizard. Follow the on-screen instructions to change 

the technology level of the connected hearing 

instruments.  

One of the steps in the wizard will provide the 

following options: • Transfer fitting 

 • Create new fitting  

If you select Transfer fitting, then the program 

structure, frequency response, acoustics, 

Automatic Adaptation Manager status and accessories in the 

current client session will be transferred to the hearing instruments after the 

technology level change is complete. If you select Create new fitting, then 

after the technology level change is completed, the HIs will be set to the 

recommended defaults. Select your desired option and continue through the 

steps in the wizard.  

Following completion of the technology change, proceed to End Fitting > 

Beeps > Trial Duration to configure the duration of the client's trial period 

with the hearing instruments. When the trial period expires, the ‘End of 

trial.’ beeps will play. See the End Fitting menu section for more details.  

Note: The transfer fitting process will reset all adaptive features to the 

recommended defaults for the new technology level.  

Note: Create new fitting will reset all hearing instrument settings including 

the acoustic options. The fitter should confirm that the hearing instrument 

parameters are set as desired following this process. 

Note: The data logging in the hearing instrument will be lost during this 

process.  

Note: The current technology level contained within the hearing instrument 

is indicated by the shaded blue button and also is displayed in the Quick View 

Pane connection tab.  
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Acoustics 

Select the Acoustics screen to configure items such 

as: 

coupling, venting, earhook, tubing, earpiece and 

receiver unit. 

BTE and RIC instruments 

• If you have ordered your earmold, cShell, Power 

Shell, or sleeve molds with IntelliVent, enter the 

code and the software will automatically use the 

optimal venting. 

• For BTE’s select Regular Tube, Slim Tube or 

Power Slim Tube (options depend on product 

style). 

• For BTEs with Slim Tube, select your Ear Piece and 

Tubing Length (optional).  

• For BTEs with Power Slim Tube, select your Ear Piece, Vent and Tubing 

Length. 

Note: The tubing length parameter is for record keeping with slim tubes and 

has no impact on the 

output of the system. In contrast, tubing length will impact products with power slim 

tubes and should be set appropriately as this parameter will influence the quick fit. 

• For BTEs with an earhook, select Vent size, Earhook type and Tubing type. 

• For RICs, select your Receiver, Ear Piece and Wire Length (optional). 

Note: The wire length parameter is for record keeping only and has no impact on the 

output of the system.  

Note: Select the Quick Fit  icon after configuring the acoustic parameters to 

ensure the product fitting considers these aspects.  

Custom instruments 

• For custom instruments, you can configure the vent. If you have ordered the custom 

products with IntelliVent, the software will automatically read the code and use the 

optimal venting.  

Note: With simulated fittings, you can also select the shell and receiver type using the 

provided drop-down menus on the Acoustics screen (if applicable). In contrast, these 

parameters are read from the detected hearing instrument and cannot be changed 

through the software. 
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Accessories 

Use the Accessories screen to add the Smart Control, 

Remote Control and/or uDirect2 accessories to your fitting. 

When the Accessories button is clicked, all accessories that 

are possible to add to this fitting will be displayed. If an 

accessory button has a check mark in the corner, then at least 

one of these accessories has been added to the fitting. You will 

also see the serial number of an activated accessory or the 

word 

Simulated if the accessory has just been simulated.  

To pair Smart Control 1. Click the Smart Control 

button. 

2. Click the Activate button.  

3. The Pair new Smart Control pairing wizard 

appears. Follow the onscreen instructions to pair the remote with the 

hearing instrument(s). 

4. After pairing, you will be provided with a graphic of the remote, along with 

check boxes and drop-down menus to configure the remote. 

5. If desired, you can also enter the serial number of the paired remote in 

the provided serial number box for record keeping purposes. 

Note: You can select the Delete  icon to remove any paired accessory from 

the fitting. You can add up to a total of 2 Smart Controls to the hearing 

instrument fitting. 

To simulate Smart Control: 

1. Click the Smart Control button. 

2. Click the Simulate button. 

3. The serial number box will say Simulated Smart Control and a graphic 

will appear with various configuration options. 

Note: You can select the Delete  icon to remove any simulated accessory 

from the fitting. You can add up to a total of 2 Smart Controls to the hearing 

instrument fitting. Any simulated remote can later be added to the fitting by 

clicking the Activate button directly beside the row assigned to the simulated 

accessory. 

To pair Remote Control: 

1. Click the Remote Control button. 

2. Click the Activate button. 

3. A Detect new accessories pairing wizard appears. Connect a USB cable to 

the remote control and your computer, and follow the on-screen 

instructions. 

4. After pairing, the serial number of the paired remote control is 

automatically shown in the serial number box. Various check boxes and a 

drop-down menu appear to configure the remote control.  

Note: You can select the Delete  icon to remove any paired accessory from 

the fitting. You can add up to 4 remote controls to the hearing instrument 

fitting. 

Note: To modify the configuration of a paired remote control, click on the 

serial number of the device you would like to modify. 
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To simulate Remote Control: 

1. Click the Remote Control button. 

2. Click the Simulate button. 

3. The serial number box will say Simulated Remote Control and a graphic 

with various configuration options appears. 

Note: You can select the Delete  icon to remove any simulated accessory 

from the fitting. You can add up to 4 remote controls to the hearing 

instrument fitting. Any simulated remote control can be added later to the 

fitting by clicking the Activate button beside the row assigned to the 

simulated accessory. 

To pair uDirect 2: 

1. Click the uDirect 2 button. 

2. Click the Activate button.  

3. A Detect new accessories pairing wizard 

appears. Connect a USB cable to the uDirect 2 

and your computer, and follow the on-screen 

instructions.  

4. After pairing, the serial number of the paired 

uDirect 2 is automatically shown in the serial 

number box. Various check boxes and a 

dropdown menu appear to configure uDirect 2. 

These controls include: 

• Notification Options 

1) Warnings only – low uDirect 2 battery; 

Bluetooth pairing process  

2) Standard – Warnings only notifications 

+ uDirect 2 on/off; starting/ending charging during streaming; 

input channel confirmation; FM announcements 

3) Detailed – Standard notifications + starting/ending charging without active 

streaming; external microphone connection; 

Bluetooth device connect/disconnect; transfer call; hold call In 

addition, you can select whether the notifications above are provided 

via ‘Beeps’ or ‘Spoken’ words. Should you select ‘Spoken’, you have the 

option of selecting:  

Language – used for the notifications, selected via the provided 

dropdown menu.  

Caller ID – select to enable / disable the use of spoken caller ID 

notification for incoming call on phones supporting this feature. 

• Phone Streaming Functions 

Access button options: 

Redial – select to enable redialing of the last number called on phones 

supporting this feature. 

Transfer call back to phone – select to enable the client to transfer a 

streamed phone call back to their paired phone. 

Connect button options: 

Voice dial – select to enable voice dialing for phones supporting this 

feature.  
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Hold – select to enable access to the functionality to put a phone call 

on hold. 

Hear own voice during call – select to allow user to hear their own 

voice during a call which is more natural sounding, especially for closed 

fittings. Select the desired attenuation for the client's own voice.  

• Remote Control Functions: check this to allow the uDirect 2 to function 

as a remote control when the hearing instrument is not in streaming 

mode. Configure the ‘Plus/Minus’ buttons as either: Smart Balance / Smart 

Balance 2 or Volume Control.  

• Allow uDirect 2 streaming to other wireless hearing instruments: 

uncheck to prevent uDirect 2 from working with hearing instruments it has 

not been paired with. 

Note: To perform remote control functions, the uDirect 2 must be paired to the 

hearing instrument. You can use the uDirect 2 without pairing it with the 

hearing instruments, but for streaming only.  

Note: You can select the Delete  icon to remove any paired accessory from 

the fitting. You can add up to 4 uDirect 2s to the hearing instrument fitting. 

Note: To modify the configuration of a paired uDirect 2, click on the serial 

number of the device you would like to modify. 

Note: The input volume correction is not required with this accessory given the 

user can configure the volume level of streamed signals via the +/- buttons on 

the front of uDirect 2 and the accessory will maintain the user’s adjustments 

for future streamed signals.  

To simulate uDirect 2: 

1. Click the uDirect 2 button. 

2. Click the Simulate button. 

3. The serial number box will say Simulated uDirect 2 and a graphic with 

various configuration options appears. 

Note: You can select the Delete  icon to remove any simulated accessory from 

the fitting. You can add up to 4 uDirect 2s to the hearing instrument fitting. 

Any simulated uDirect 2 can be added later to the fitting by clicking the 

Activate button beside the row assigned to the simulated accessory.  

Note: uDirect 2 does not need to be paired to work with Vista hearing 

instruments. 

Pre-Fitting screen 

Use the Pre-Fitting screen to change the fitting formula, 

processing strategy, and tinnitus masker strategy (only 

used by products supporting this feature) used in the 

current fitting by clicking on the desired icon at the 

bottom of the screen.  

Fitting Formula 

1. Click the Fitting Formula task at the bottom of the 

screen. 

2. Select your desired fitting formula from the 

provided drop-down menu: DSL v5 Adult, DSL v5 

Pediatric, NAL-NL1 or NAL-NL2. 
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Processing Strategy 

1. Click the Processing Strategy task at the bottom of the screen. 

2. With DSLv5 adult or DSLv5 pediatric, select your desired processing 

strategy from the drop-down menu: WDRC or Linear. 

Note: Selecting NAL-NL2 or NAL-NL1 provides a WDRC processing option 

only.  

Tinnitus Masker Strategy 

1. Click the Tinnitus Masker Strategy task at the bottom of the screen. 

2. Select your desired tinnitus masker signal strategy from the drop-

down menu: Audiogram-based, White Noise, or Pink Noise 

Note: The tinnitus masker strategy impacts the quick fit calculation for the 

frequency shape of the tinnitus masker noise. The tinnitus masker noise can 

be viewed and fine tuned in the Fitting > Configure Features > Tinnitus 

Masker task box. 

 In Situ 

Use the In Situ screen to assess hearing sensitivity and uncomfortable 

loudness levels via signals generated by the hearing instruments. The In 

Situ measurement results can be used to define the fitting formula targets.  

1. Click on the Start In Situ button for the device / ear you would like to 

assess. 

2. An In Situ wizard will appear. Preparation information is provided to 

assist with the test. 

3. Select the coupling option to be used for the In Situ test. The options 

available will depend on the form factor being fitted and can include: a. 

 Vented (current vent value).  

Note: Ensure the product venting is configured correctly in the acoustics 

screen as it will impact the signal level generated by the device. b. 

 Temporarily occluded earpiece.  

4. After the coupling option is selected, click Continue to get to the In Situ 

measurement step.  

5. Select the desired measurement type (AC: air conduction or UCL: 

uncomfortable loudness level) via the appropriate button. 

6. Select the desired frequency /presentation level by clicking on the graph. 

7. Present the tone by using the space bar or by clicking the Present Tone 

button. 

8. To present tones automatically when you click on the graph, select the 

Enable Autoplay option.  

9. If you desire to present tones at a loudness level beyond the safety limit 

of 100 dB HL, select the Enable HL > 100 dB HL option. 

10. To speak with the client during the test, the hearing 

instrumentmicrophones must be enabled by clicking on the Talk to 

Client button. The volume level of the device can be adjusted as 

required using the up/down volume arrow keys.  

If you would like to use the In Situ data as the basis for the hearing 

instrument quick fit, check the Use In Situ data to recalculate hearing 

instrument settings check box.  
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Following completion of the test, the In Situ data will be displayed on the 

graph, along with any previous standard audiometric data if it is available. 

Note: If a previously entered audiogram is available in the session, it will be 

shown faded into the background for reference purposes on the In Situ and 

Audiogram screens.  

Click on Use Audiogram to use the entered standard audiometric data for 

fitting formula targets. 

Click on Use In Situ to use the measured In Situ data for fitting formula 

targets.  

Note: The In Situ data can be deleted using the Remove (Delete)  icon 

above the graph.  

If desired, speech sounds and common sound icons can be displayed on the 

audiogram for counseling purposes by selecting the check box for the 

desired information. 

Fitting menu 

 
Select the Feedback Optimization screen to run the feedback test. 

1. Click the Start feedback test button for the device/ear you would like to 

assess. 

2. Follow the on-screen instructions to perform feedback optimization.  

The status of the test appears above the graph (complete, incomplete, not 

run). In cases where the environment may have impacted the test (e.g., 

excess noise present), the final results include a combination of measured 

values and predicted feedback threshold values. The status then indicates 

Incomplete. Repeating the test will replace any predicted values with 

measured values if they can be reliably obtained in the current test 

environment.  

Once the feedback test is completed, the hearing instrument’s gain is limited 

as shown on the graph where: 

• Black line = feedback threshold 

• Grey line = hearing instrument gain limit 

• Green line = target gain for 50 dB pure tone input 

• Red or Blue line = aided gain for 50 dB pure tone input 

Note: If desired, the feedback test can be deleted using the Delete icon 

above the graph for the device / ear in question.  

Note: The phase canceller is enabled prior to running the feedback 

optimization test and the quick fit will be limited to the predicted maximum 

stable gain. Following the feedback test, the device is automatically quick 
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fitted up to the desired adaptation manager level setting, but not beyond the 

measured maximum stable gain curve. 

Program Manager screen 

Select the Program Manager screen to add or 

remove additional manual programs, copy 

programs, rename programs, change program 

order, and assign Auto Phone / Auto DAI access 

(when applicable). 

To add programs to the manual program list: 

1. Select the program name under the 

Available Programs list or click the arrow  
next to the program name OR 

2. Click the Copy  icon beside the program 

that you would like to copy from the 

Selected Programs list. 

To remove manual programs: 

• Click on the Delete  icon next to the program in question.  

To rename programs: 

• Click the program name under the Selected Programs header.  

To assign Auto Phone to a program in devices supporting this feature: 

• Add a telephone program that has Auto Phone capability and select 

the Auto Phone check box beside that program in the column list. 

Note: Auto Phone can only be assigned to one telephone program 

To assign Auto DAI to a program in devices supporting this feature: 

• Add a DAI program and select the Auto DAI check box beside that 

program in the column list. 

Note: Auto DAI can only be assigned to one DAI program. 

To reorder manual programs: 

• Click on the Move Program Up  or Move Program Down 

icon next to the program in question.  

Note: To select which program is the start-up program, go to the End 

Fitting > HI Setup > Startup Settings task box. By default, the Auto 

Program is the start-up program when it is included in the program 

toggle sequence. To remove the Auto Program, Auto Phone and/or Auto 

DAI from the program toggle sequence, go to the End Fitting > HI Setup 

> Program Toggle Exceptions task box. 

Note: Mute program is only available for some products. If the mute 

program is not available, then create a Quiet program and then change the 

Input strategy under Fitting > Configure Features.  
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Configure Features 

Select the Configure Features screen to adjust 

various adaptive parameters in the hearing 

instrument by clicking the desired task item at 

the bottom of the screen. These options include: 

Phase Canceller, Pulse Protector, 

Smart Balance / Smart Balance 2, Wind Noise 

Manager, Input, Tinnitus Masker (when a 

product supports this feature), Automatic 

Controls, Music Equalizer (when a music program 

or environment is selected), and Binaural Phone 

(when telephone program is selected in a 

binaural wireless fitting). The adaptive feature 

settings for each program will automatically 

default to suggested values.  

Prior to adjusting any adaptive feature, select the program you would like to 

manipulate from the program selector list on the left side of the screen. The active 

program is highlighted and its name is also listed above the graphs and in between 

the mute buttons.  

Note: Within the configuration boxes for the various adaptive features, both ears are 

linked by default. To unlink both ears, click the link / unlink  icon within each 

feature’s task box.  

Phase Canceller  

1. Click the Phase Canceller task item at the bottom of the screen. 

2. Select your desired phase canceller strength using the provided slider. 

Note: This feature is global for all Auto Program environments. 

Pulse Protector 

1. Click the Pulse Protector task item at the bottom of the screen. 

2. Select your desired Pulse Protector strength using the provided slider. 

Note: This feature is global for all Auto Program environments. 

Smart Balance / Smart Balance 2 Configuration 

1. Click the Smart Balance / Smart Balance 2 Configuration task item at the 

bottom of the screen. 

2. Select your desired position using the provided slider. 

Note: If desired, click on the  icon to view the frequency response.  

Wind Noise Manager  

1. Click the Wind Noise Manager task item at the bottom of the screen. 

2. Select your desired wind noise manager strength using the provided slider. 

Input 

1. Click the Input task item at the bottom of the screen. 

2. The available input options depend on the product and program being 

adjusted: 

• Auto Program environments - Smart Directional (input is dependent on Smart 

Balance position), Omni (some products only). 

• Acoustic manual programs - Omni (Mic), Fixed Directional, Adaptive Directional, 

Smart Directional, Mute 
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• Wireless streaming programs - Audio Streaming + Mic, Audio Streaming 

• Telephone programs – Telecoil, Telecoil + Microphone, Omni (Mic), Mute 

• DAI programs - Direct Audio Input + Mic, Direct Audio Input, Mute 

Note: For environments that offer mixed inputs (e.g., Telecoil + Microphone, Audio 

Streaming + Mic, Direct Audio Input + Mic), the microphone level can be adjusted using 

the mic attenuation slider in 3 dB steps from 0 to -30 dB with the exception of Auto DAI. 

Note: When Binaural Phone is activated, the input selection task box offers the ability to 

configure phone ear inputs (Telecoil + Microphone with 0 to -30 dB mic attenuation; or 

Omni) and non-phone ear inputs (Audio Streaming + Mic with optional 6 dB mic 

attenuation available with some products).  

Tinnitus Masker 

Note: This option is available when the product supports this feature. 

1. Click the Tinnitus Masker task item at the bottom of the screen. 

Note: The graph view will automatically change to 'output' upon selection of the tinnitus 

masker task box to allow you to view the tinnitus masker output level relative to the 

hearing aid output settings.  

2. Click the Enable Tinnitus Masker check box to activate the masker noise. Note: 

The tinnitus masker noise is disabled by default. When it is enabled, the quick fit 

level should be at a soft but audible level.  

Note: The calculated masker noise level with the current settings will be displayed in 

dB(A) in the task box. 

3. Click the checkbox beside Use client control to adjust noise level to allow patient 

to adjust the noise level using any volume or Smart Balance control on the hearing 

instruments or accessories. Selecting this option will prevent the client from 

adjusting the gain or the Smart Balance setting for this program.  

Note: This setting is binaural and cannot differ across hearing instruments in the same 

fitting, even if the tinnitus masker is disabled or not available in one hearing instrument. 

4. Select the frequency resolution you require for your modification using the 

provided tabs. Note: The frequency resolution depends on the technology level of 

the product you are fitting. 

5. Select the frequency region(s) to be modified in the table. 

• To select an individual frequency region, select the desired value in the table. 

• An entire frequency range of fitting values can be selected by choosing the 

'Noise' label. 

• To select multiple frequency regions for adjustment, you can also click and drag 

across the table. The slider bar along the bottom of the table allows you to view 

frequency regions that are outside the visible table area. 

• To view all frequency regions for a particular ear, and/or increase the size of the 

selectable boxes in the table, click on the View right ear only or View left ear 

only text as appropriate. To change the table view back to a binaural view, click 

on the text View both ears. 

• Once you have selected your desired frequency region for adjustment, click the 

dB drop-down menu to alter the step size of any change. Choose from 1, 2 or 3 

dB. 

• Click the + or - buttons to apply the desired change. 
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Note: When a fitting handle has reached its maximum setting, the + button will grey out 

(disable). Conversely, if a fitting handle is at its minimum setting, the - button will grey 

out (disable). 

Note: The alerts tab will highlight once the generated masker noise setting reaches a 

value of 80 dB(A) or greater to indicate that care should be taken when exposing the 

client to continued noise at this level to avoid an adverse impact on hearing. A 

recommended daily usage time based on NIOSH standards 

(http://www.cdc.gov/niosh/docs/98-126/) will also be indicated considering the current 

masker noise level and updated as the noise level is adjusted. The noise level settings will 

be limited such that the generated noise never exceeds a level of 85 dB(A), assuming at 

least 8 hours of use / day to address concerns regarding the impact of continued noise 

exposure on hearing sensitivity from NIOSH guidelines.  

Note: The tinnitus masker settings are global for the Auto Program, so they will be the 

same in all Auto Program environments, but the settings can vary across manual 

programs.  

Automatic Controls 

Note: This option is available when the Auto Program or one of its environments are 

selected. 

1. Click the Automatic Controls task item at the bottom of the screen. 

2. If desired, select the client’s Highest Priority and Lowest Priority environments 

from the provided drop-down menus.  

3. If desired, adjust the Sensitivity control using the provided drop down menu to 

impact how quickly the Auto Program responds to changes in the environment.  

Note: The automatic controls should be left in their default positions for the initial fitting 

and reviewed later if the client has concerns regarding the instruments’ switching 

behaviour.  

Note: This feature is global for all Auto Program environments. 

Binaural Phone 

Note: This feature is available when a telephone program is selected in a binaural 

fitting with some wireless products. 

1. Click the Binaural Phone task item at the bottom of the screen. 

2. Click the Enable Binaural Phone check box to activate this feature.  

Note: This feature is active by default. 

3. Select the client’s Preferred Phone Ear from the provided drop-down menu. 

This choice impacts the streaming direction when Binaural Phone is activated 

using the remote control phone button. 

4. Click the Push button selects phone ear check box to have the system stream 

the phone signal in either direction based on which push button was used to 

toggle into the Binaural Phone program. That is, the phone ear is identified as 

the side which had its push button activated.  

Note: When accessing Binaural Phone streaming using Auto Phone, the phone ear is 

automatically identified as the side that triggered Auto Phone (ie., the ear where the 

phone receiver is located). 

Note: When Binaural Phone is activated, the Input selection task box offers the ability 

to configure phone ear inputs (Telecoil + Microphone with 0 to -30 dB mic attenuation; 
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or Omni) and non-phone ear inputs (Audio Streaming + Mic with optional 6 dB mic 

attenuation available with some products).  

Music Equalizer 

Note: This option is available when a music environment or program is selected. 

1. Click the Music Equalizer task item at the bottom of the screen. 

2. Choose one of the default offsets from the provided drop-down menu.  

Tuning 

Select the Tuning screen to adjust various 

parameters in the hearing instrument by clicking 

the desired item at the bottom of the screen. 

These options include: Adaptation Manager, 

Occlusion Manager, Bass Enhancer (some 

products only), Soft/Mod/Loud Controls, 

MPO/Gain/CR Controls, Frequency Compression 

(some products only) and Fitting Advice. The 

settings for each program automatically default to 

suggested values. 

Prior to adjusting any of the parameters listed 

above, select the program you would like to tune 

from the program selector list on the left side of 

the screen. The active program is highlighted and 

its name is listed above the graphs and in between the mute buttons.  

Note: All Programs is selected by default in the Tuning section. This ensures 

that the relative differences across all programs are maintained when 

making changes and helps to maintain seamless transitions in the Auto 

Program.  

To fine tune the hearing instrument: 

1. Select the desired program from the program selector list on the left side 

of the screen. 

• To select all programs for modification, click the All Programs 

button at the top of the program selector list. 

• To select all Auto Program environments, click the Automatic 

program header above the individual environments.  

• To select all manual programs, click the Manual program header 

above the individual manual programs.  

• To select all wireless programs, click the Wireless program header 

above the wireless programs. 

• To select an individual program or environment, click the program 

name or environment in the program selector list. 

Note: To simplify the view, you can click the chevron  icon beside the 

program header to collapse or expand the program list for that category. 

Note: To simplify the view and expand the size of the graphs, you can click 

the side arrow to the immediate right of the program selector list to hide 

and reveal the program selector list. 
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Adaptation Manager 

1. Click on the Adaptation Manager task item at the bottom of the 

screen.  

2. Select the Automatic check box to activate the Automatic Adaptation 

Manager (AAM). With some products, select the Automatic / Power check 

box to activate the Automatic Adaptation Manager or the Power 

Adaptation Manager (PAM). The software will use a proprietary calculation 

that considers the client’s hearing loss, age, and hearing instrument 

experience level (as indicated on the client information screen) to 

determine the starting adaptation manager setting and the adaptation rate 

for the fitting. 

3. If desired, select the speed of adaptation for the current fitting using the 

provided dropdown box. Choose from the following adaptation rates:  

• 5% per week 

• 5% per 2 weeks 

• 5% per 3 weeks 

• 5% per 1 month 

• 5% per 2 months 

• 5% per 3 months 

• 5% per 4 months 

• 5% per 5 months 

• 5% per 6 months 

Note: For products with Automatic / Power, when the Current value is above 

the End Value, the above choices represent the approximate time for a 5% 

decrease in the current value of PAM.  

Note: For calculation purposes, the adaptation rate assumes one week of use 

= 70 hours (i.e., 10 hours / day). Thus at the follow-up appointment, the 

Current position may differ from what is expected based on calendar days 

depending on the client’s actual usage time per week.  

4. If desired, the fitter can adjust the Current position (% of target) and the 

desired End Value (% of target) for the chosen fitting formula using the 

provided sliders. If this is a follow-up fitting, and the Automatic Adaptation 

Manager is enabled, then you will see a grey bar representing the 

adaptation progress that has been made so far.  

Note: The predicted Time remaining to reach the end value will be updated 

automatically depending on the relative position of the Current and End 

Value sliders.  

Note: If desired, the AAM or PAM can be disabled by de-selecting the check box. 

The fitter can then select their desired adaptation manager setting using the 

Current slider. 

Note: This feature is global and will impact all programs. 

Note: For products with Automatic / Power, adaptation manager settings above 

100% affect both the '% of target gain' provided and the MPO setting of the 

hearing instrument. Adaptation manager settings below 100% impact only % of 

target gain.  

Occlusion Manager 

1. Click the Occlusion Manager task item at the bottom of the screen. 
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2. Select your desired occlusion manager setting using the provided slider to 

address any occlusion related complaints.  

Note: This feature is global and will impact all programs. 

Bass Enhancer 

Note: This option is only available with some products. 

1. Click the Bass Enhancer task item at the bottom of the screen. 

2. Select your desired bass enhancer setting using the provided slider to 

increase low frequency gain and MPO (emphasis below ~ 1 kHz).  

Note: This feature is global and will impact all programs. 

Soft / Mod / Loud Controls 

1. Click the Soft / Mod / Loud Controls task item at the bottom of the 

screen. 

2. Select the program(s) you wish to modify using the program selector list 

as described above.  

3. Select the frequency resolution using the provided tabs. 

Note: The frequency resolution depends on the technology level of the 

product you are fitting. 

4. Select the frequency region(s) and input level(s) to be modified in the 

provided table: 

• To select an individual frequency region, select the desired value in the 

table.  

• A range of fitting values can be selected by either choosing a specific 

input label (loud, mod, soft), channel grouping label (low, mid, high or 

specific frequency columns) or the All table label. The selected frequency 

region(s) are highlighted in the table and shaded in the fitting graph. 

• To select multiple frequency regions for adjustment, you can also click 

and drag across the table. The slider bar along the bottom of the table 

allows you to view frequency regions that are outside the visible table 

area.  

• To view all frequency regions for a particular ear, and/or increase the size 

of the selectable boxes in the table, click on the View right ear only or 

View left ear only text as appropriate. To change the table view back to a 

binaural view, click on the text View both ears. 

• Once you have selected your desired region for adjustment, click the dB 

dropdown menu to alter the step size of any change. Choose from 1, 2 or 

3 dB. 

• Click the + or - buttons to apply the desired change. 

Note: When a fitting handle has reached its maximum setting, the + button 

will grey out (disable). Conversely, if a fitting handle is at its minimum 

setting, the - button will grey out (disable).  

Note: The table will also display the calculated compression ratios. The 

compression ratios are calculated based on the slope of the I/O curve 

between the TK soft and TK loud inputs. 

MPO / Gain / CR / TK 

1. Click the MPO / Gain / CR / TK task item at the bottom of the screen. 



Vista:fit software instruction guide v2.2 

29 

2. Select the program(s) you wish to modify using the program selector list as 

described above.  

3. Select the frequency resolution you require for your modification using the 

provided tabs.  

Note: The frequency resolution depends on the technology level of the 

product you are fitting. 

4. Select the frequency region(s) and parameter type (MPO, Gain , CR or TK) 

to be modified. 

• To select an individual frequency region, select the desired value in the 

table. 

• A range of fitting values can be selected by choosing a specific parameter 

label (MPO, Gain, CR or TK). The selected frequency region(s) is 

highlighted in the table and shaded in the fitting graph. 

• TK soft speech can be used to adjust the gain for low level sounds. Impact 

of the adjustments is opposite to the other controls: increasing TK soft 

speech will decrease gain for low level sounds and vice versa. 

• To select multiple frequency regions for adjustment, you can also click 

and drag across the table. The slider bar along the bottom of the table 

allows you to view frequency regions that are outside the visible table 

area. 

• To view all frequency regions for a particular ear, and/or increase the size 

of the selectable boxes in the table, click on the View right ear only or 

View left ear only text as appropriate. To change the table view back to a 

binaural view, click on the text View both ears. 

• Once you have selected your desired region and parameter type for 

adjustment, click the dB drop-down menu to alter the step size of any 

change. Choose from 1, 2 or 3 dB. 

• Click the + or - buttons to apply the desired change. 

Note: When a fitting handle has reached its maximum setting, the + button will 

grey out (disable). Conversely, if a fitting handle is at its minimum setting, the 

button will grey out (disable) 

Note: The compression ratios are calculated based on the slope of the I/O 

curve between the TK soft and TK loud inputs. 

Note: The TK soft speech control is only available if you have selected to show it 

under Options > Preferences > Fitting Session > Fitting. 

Frequency Compression 

Note: This option is only available with some products. 

1. Click the Frequency Compression task item at the bottom of the screen. 

2. Select the program you wish to modify using the program selector list 

described above. 

Note: This feature is global within the Auto Program and can be set 

independently for each of the manual and wireless programs. 

3. Click the Enable Frequency Compression check box to activate / deactivate 

this feature.  

Note: This feature is activated by default for some products. 

4. Adjust the Frequency Compression to the desired setting using the More or 

Less buttons. Adjusting the frequency compression impacts: 
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• The frequency at which the compression will begin. Below this 

specified cut-off, no frequency compression will be applied.  

• The compression ratio or the amount of compression that will be 

applied in the frequency domain above the cut-off frequency.  

Note: The software will automatically calculate the starting default position of 

the frequency compression based on the client's better ear audiogram and the 

fitting formula. With the DSL v5 pediatric fitting formula, frequency 

compression default settings are more aggressive (i.e. lower cut-off frequency, 

higher compression ratio) to emphasize audibility of high frequency speech cues 

for children. 

Note: For clients with asymmetrical hearing loss, the frequency compression 

settings will be based on the audiometric thresholds from the better ear and 

applied to both devices in binaural fittings. 

Note: The shaded region on the slider reflects the frequency compression 

region which is also displayed on the frequency response graphs.  

Fitting Advice 

1. Click the Fitting Advice task item at the bottom of the screen.  

2. Select the program(s) you wish to modify using the program selector list as 

described above.  

3. Select the situation (type of sound environment) that is problematic for the 

client using the Select Situation dropdown box.  

4. Select the concern that best describes the client’s complaints for that sound 

type using the Select Concern dropdown box.  

5. A description of the proposed change appears on the screen and an associated 

sound file is automatically selected by the media player. 

6. If desired, play the associated sound file and/or apply the suggested change 

using the Apply button. Any previously applied undesirable changes can be 

removed using the Undo button.  

Data logging  
Select the Data logging screen to observe clients’ usage patterns at follow-up 

appointments. At the initial fitting, no data logging information will be available.  

Note: If you want to enable or disable data logging, self learning and Teach in 

the product, navigate to the End Fitting Section > HI Setup > Data logging task 

icon box. The availability of self learning and Teach will depend on the product.  

Note: Saving to the hearing instrument will overwrite any data logging 

information stored on the hearing instruments. You should read from the 

hearing instruments at the follow-up appointment to view the data logging 

details before saving any changes to the hearing instruments.  

The navigation tab along the left side of the data logging screen allows you to 

select from various summary screens. Choose from:  

• All Programs: Overview  

• Auto Programs: Summary 

• Manual Programs: Summary 

• Wireless Programs: Summary 



Vista:fit software instruction guide v2.2 

31 

All Programs: Overview 

The All Programs Overview screen provides a summary of the total usage 

patterns of all programs in the hearing instrument. A histogram chart shows 

a breakdown of total percentage of use in each of the available program 

categories (Auto, Manual and Wireless programs). 

A table below the chart also identifies: 

• Hours / Day 

• Total Days 

• Program usage breakdown by category 

• Further details regarding the individual programs/destinations within 

each category can be found by clicking the chevron  icon to expand 

and collapse the table.  

Note: Expanding/collapsing the table will also impact the information 

displayed in the summary histogram chart.  

Auto Programs: Summary 

The Auto Programs Summary screen provides an overview of the learned (or 

logged) user adjustments for Smart Balance, volume control and tinnitus 

masker (if applicable) in each of the automatic environments. A histogram 

chart shows a breakdown of percentage of use of each automatic 

environment relative to the total Auto Program usage time.  

A table below the chart also identifies: 

• Average usage for each environment in percent  

• Learned user adjustments for volume control for each environment 

• Learned user adjustments for Smart Balance for each environment (if 

available) 

• Logged user adjustments for tinnitus masker for each environment  

(if active in product and enabled on user control) 

Note: If learning is inactive or unavailable in the product, the data logging 

table will reflect logged adjustments as labeled in the table header. 

Note: Tinnitus masker changes (if applicable to product and activated on 

user controls) are only logged even if learning is activated in the hearing 

instruments. 

• In the case of learned data, you can remove learning from all 

automatic environments for both VC and Smart Balance binaurally 

with the Remove button. 

• In the case of logged data, you can apply logged data to all automatic 

environments for both VC and Smart Balance binaurally with the 

Apply button.  

Note: If you would like to apply tinnitus masker noise level adjustments, you 

must go to the Tinnitus Masker task under Fitting > Configure Features and 

adjust the tinnitus masker noise level for each program.  

Manual Programs: Summary 

The Manual Programs Summary screen provides an overview of the learned 

(or logged) user adjustments for Smart Balance, volume control and tinnitus 

masker (if applicable) in each of the manual programs. A histogram chart 

shows a breakdown of percentage of use of each manual program relative 
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to the total Manual Program usage time. A table below the chart also 

identifies: 

• Average usage for each manual program in percent  

• Learned user adjustments for volume control for each manual 

program  

• Learned user adjustments for Smart Balance for each manual program 

(if available) 

• Logged user adjustments for tinnitus masker for each manual program 

(if active in product and enabled on user control) 

Note: If learning is inactive or unavailable in the product, the data logging 

table will reflect logged adjustments as labeled in the table header. 

Note: Tinnitus masker changes (if applicable to product and activated on 

user controls) are only logged even if learning is activated in the hearing 

instruments. 

• In the case of learned data, you can remove learning from all manual 

programs for both VC and Smart Balance binaurally with the Remove 

button. 

• In the case of logged data, you can apply logged data to all manual 

programs for both VC and Smart Balance binaurally with the Apply 

button. 

Note: If you would like to apply tinnitus masker noise level adjustments, you 

must go to the Tinnitus Masker task under Fitting > Configure Features and 

adjust the tinnitus masker noise level for each program.  

Wireless Programs: Summary 

The Wireless Programs Summary screen provides an overview of the learned 

(or logged) user adjustments for Smart Balance, volume control and tinnitus 

masker (if applicable) in each of the wireless programs. A histogram chart 

shows a breakdown of percentage of use of each wireless program relative 

to the total wireless program usage time.  

A table below the chart also identifies: 

• Average usage for each wireless program in percent  

• Learned user adjustments for volume control for each wireless 

program 

• Learned user adjustments for Smart Balance for each wireless 

program (if available) 

• Logged user adjustments for tinnitus masker for each wireless 

program (if active in product and enabled on user control) 

Note: If learning is inactive or unavailable in the product, the data logging 

table will reflect logged adjustments as labeled in the table header. 

Note: Tinnitus masker changes (if applicable to product and activated on 

user controls) are only logged even if learning is activated in the hearing 

instruments. 

• In the case of learned data, you can remove learning from all wireless 

programs for both VC and Smart Balance binaurally with the Remove 

button. 
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• In the case of logged data, you can apply logged data to all wireless 

programs for both VC and Smart Balance binaurally with the Apply 

button.  

Note: If you would like to apply tinnitus masker noise level adjustments, you 

must go to the Tinnitus Masker task under Fitting > Configure Features and 

adjust the tinnitus masker noise level for each program.  

Note: For all summary screens with volume control and/or tinnitus masker 

data, ‘–’ values represent dB decrease relative to previous default position, 

while ‘+’ values represent dB increase relative to default position. 

Note: For all summary screens with Smart Balance data,  steps represents 

movement of Smart Balance towards max clarity direction from previous 

setting, while  steps represents movement of Smart Balance toward max 

comfort direction from previous setting. 

End Fitting menu 

 

from: 

• Program change - press the push button to toggle through the 

various listening programs.  

Note: Wireless synchronization is on by default in binaural wireless 

product fittings to ensure the program setting in both devices is 

synchronized when the program toggle on one device is activated. 

• Volume Control: Right up, Left down - pressing the push button 

on the right device increases the volume for both hearing 

instruments. Pressing the push button on the left device decreases 

the volume for both hearing instruments.  

Note: Wireless synchronization must be on for this setting to function. 
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• Smart Balance: R clarity, L comfort - pressing the push button on 

the right device moves the Smart Balance setting towards clarity for 

both hearing instruments. Pressing the push button on the left 

device moves the Smart Balance setting towards comfort for both 

hearing instruments.  

Note: Wireless synchronization must be on for this setting to function. 

• Off: the push button is disabled on the hearing instruments.  

Note: The program toggle on a remote control is not impacted by the 

setting of this control.  

To configure the function of the lever / dial on the hearing 

instrument(s) (if available): 

 1. Click the drop-down menu under the lever / dial label on the primary screen. 

Choose from: 

• Volume Control: the lever / dial adjusts the volume level of the hearing 

instruments.  

Note: Wireless synchronization is disabled by default to allow independent 

adjustment of this control on each ear. 

• Smart Balance: the lever / dial adjusts the Smart Balance setting in the hearing 

instrument. 

Note: Wireless synchronization is disabled by default to allow independent 

adjustment of this control on each ear. 

• No function (Off): the lever / dial is disabled on the hearing instrument.  

Note: A remote control is not impacted by the setting of this control.  

Note: Only one user control on the hearing instrument can be assigned to 

perform a particular function. While both the push button and lever/dial can 

be configured as either a volume control or a Smart Balance control, both 

controls cannot perform the same function.  

To configure the function of the Micro CIC remote (if available): 

1. Click the drop-down menu under the Micro CIC remote function label on the 

primary screen. Choose from: 

• Off: the micro CIC remote is disabled.  

• Program change: bring the remote up to each hearing instrument to toggle 

through the various listening programs.  

• Volume up: bring the remote up to each hearing instrument to increase the 

volume in steps. Once the hearing instrument reaches the maximum volume, 

the next step will bring it back to the default volume level.  

• Volume down: bring the remote up to each hearing instrument to decrease 

the volume in steps. Once the hearing instrument reaches the minimum 

volume, the next step will bring it back to the default volume level.  

Volume Settings 

1. Click the Volume Settings task item at the bottom of the screen. 

2. Select the desired amount of increase in volume using the Volume Control Up 

drop-down menu. 

3. Select the desired amount of decrease in volume using the Volume Control 

Down drop-down menu. 
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Note: The value selected in the volume control up and down boxes determines the 

volume control range provided to the client (as displayed in the volume settings 

task box). Each adjustment of the volume control using a remote control or on the 

hearing instruments is 2 dB.  

Start up Settings 

1. Click the Start up Settings task item at the bottom of the screen. 

2. Select the desired Start up Program from the drop-down menu.  

3. Select the desired Start up Delay from the drop-down menu. Choose 

Minimum, 10 second delay or 15 second delay. 

Data Logging 

1. Click the Data Logging task item at the bottom of the screen. 

2. Select the desired data logging and learning parameters (if applicable) 

from the drop-down menu. Choose from Logging & Self Learning & 

Teach, Logging & Self Learning, Data logging on or Data logging off. 

Note: The presence or absence of Teach in the selected drop-box menu on 

this screen changes the configuration of the Teach button on the Smart 

Control remote. Similarly, the configuration of the Teach checkbox on the 

Smart Control Accessories screen changes the selection in the Data Logging 

task box. 

Program Toggle Exceptions 

1. Click the Program Toggle Exceptions task item at the bottom of the 

screen.  

2. Uncheck the boxes to indicate which of the following you would like to 

exclude from the program toggle sequence:  

• The Auto Program 

• The Auto Phone program (if applicable to the product being fitted)  

• The Auto DAI program (if applicable to the product being fitted)  

 
input activation, uFM activation, or  

Smart Control telephone button activation. 

 

 

 

 

 

 

 

There are a number of play buttons  

 

the product being fitted, you have the option  

 

•  

 

• Automatic Events: choose from 
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• Warnings / Alerts: choose from low battery and Teach (if applicable). 

• Trial Duration: play the 'End of trial period' beeps that will be 

generated in trial devices once the trial period has expired. 

• Volume / Smart Balance: choose from: volume min/max, volume ideal 

(default), Smart Balance min/max, Smart Balance ideal (default), 

volume step change, Smart Balance step change. 

• Phone Ring Tones: play provided ring tone. 

Note: The phone ring tone notification is generated during uPhone activation 

with phones supporting this feature. 

To play the selected notification through the hearing instrument, click the 

right or left play buttons beside the chosen drop-down menu. 

Beep Setup 

1. Click the Beep Setup task item at the bottom of the screen. 

2. Select the intensity level from the drop-down menu. Choose from: 

Very Soft, Soft, Moderate, Loud, or Very Loud. 

3. Select the frequency from the drop-down menu. Choose from: Low, 

Medium or High.  

Beep Enabling 

1. Click the Beep Enabling task item at the bottom of the screen.  

2. Select the beep notification types you would like active for the client. 

Choose from: Program Change, Start Up Sound (initial sound which 

occurs upon the powering up of the hearing instruments), Automatic 

Events (events listed under the demo drop-down menu for this 

category), VC & Smart Balance Min/Max (end of range), VC & Smart 

Balance steps (beeps that occur each time these user controls are 

changed), and Warning / Alerts (events listed under the demo 

dropdown menu for this category).  

Note: The beeps that play at the end of the trial period with Trial hearing 

instruments cannot be disabled. When the end of trial period beeps start to 

sound, fitters can turn off the repeated beeps by resetting the trial period, 

i.e. by detecting and then saving to the hearing instruments.  

Trial Duration 

Note: This option is available with Trial devices. 

1. Click the Trial Duration task item at the bottom of the screen. 

2. Select the desired trial duration before the 'End of trial period' beeps are 

generated in the hearing instruments. 

Note: Once the trial duration has been exceeded, repeated beeps (End of trial 

period beeps) will be generated. Initially, these beeps will occur every hour 

for ~ 3 days of use, after which the instruments will repeatedly generate the 

beeps every minute. 
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Fitting Summary 

The Fitting Summary screen provides a succinct 

overview of primary fitting-related items in an 

easy-to-read table for each hearing instrument. 

The table provides an opportunity for a final 

check of the fitting settings and general status 

prior to printing, saving and closing the session.  

The default table information is dependent on 

the product being fitted and can include: 

Program List, Client Controls, General Status, 

Accessories, and Indicators. If desired, additional 

details can be obtained by clicking the More Info 

button which then displays Fitting Settings and 

Acoustics. Items outside the primary viewing 

area can be observed by adjusting the vertical 

scrolling slider.  

To end the fitting: 

1. Select the check boxes for the items you would like to print (e.g., Fitting 

reports, Getting Started Guides for hearing instruments and accessories, 

if applicable). The client's language for the Getting Started Guides can be 

selected. Click the Print & Save button. If you do not desire to print any 

materials, remove the check marks and click the relabeled Save button. 

2. Select the check boxes for the items that you would like to save (e.g., 

Save to hearing instruments, Save to database, Save to accessories) on 

the save dialog pop-up window. Click Save and then Close in the save 

confirmation window.  

Note: Clicking the Save  icon on the primary tool bar or accessing the 

File > Save function in the main menu also provides the ability to save to 

the hearing instruments and save to the database. 

3. To close the session, click the Close Session button. If you have not yet 

saved the fitting, the save dialog pop-up window will appear. When 

running Vista:fit under NOAH click the Exit Vista:fit button.  

4. After closing the session: 

• If using iCube, restart your hearing instrument(s) by opening and 

closing the battery door(s). 

• If using NOAHlink or HI-PRO, remove the programming cable, insert 

the batteries and close the battery door. 
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